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Shelly Cashman: Microsoft Access 2021

Module 1: Databases and Database Objects: An Introduction
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Objectives (1 of 2)

•Describe the features of the Access window

•Create a database

•Create tables in Datasheet and Design views

•Add records to a table

•Close a database
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Objectives (2 of 2)

•Open a database

•Create and use a query

•Create and use a form

•Create a report

•Perform special database operations
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Introduction

•What is a database?

•A collection of data organized in a way so that it can easily 
be accessed, managed and updated

•Microsoft Access 2021 (or Access) is a database 
management system

•A database management system is software that allows 
you to use a computer to 

• create a database

• add, change, and delete data in the database

•Ask and answer questions about the data

• Create forms and reports using the data
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Access vs. Excel

• Access and Microsoft Excel possess many similarities

• Both store large amounts of data, perform sophisticated 
calculations, run powerful queries and analysis tools

• Access is better for managing data: helping you keep it 
organized, easy to search, and available to multiple 
simultaneous users

• Excel is generally better for analyzing data: performing 
complex calculations, exploring possible outcomes, and 
producing high quality charts
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CMF Vets Appointment System (1 of 2)

•CMF Vets wants to computerizes its appointment system 
with an Access database (the old system is manual)

•To make the system easier to use and more efficient, 
CMF Vets needs to record all information about its 
practice, including the following:

1) pet owners

2) patients

3) appointments

4) treatment costs

5) veterinarians  
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CMF Vets Appointment System (2 of 2)

•The database will consist of five tables to store these 
information

•Each table will contain information about a specific 
subject

•Tables can be related through a common value

•A database consisting of a collection of tables which are 
related to each other is called a relational database

•With the database management system such as Access, 
CMF Vets can easily track its patients and create a 
variety of useful reports
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Project—Database Creation (1 of 2)
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The rows in the tables are called records.The columns in the tables are called fields.



Project—Database Creation (2 of 2)
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Creating a Database (1 of 4)

•A database is a structure that can store information 
about multiple types of objects, the properties of those 
objects, and the relationships among the objects 

•To Create a Database

• Run Access

• If you know what the tables and fields you want in the 
database, use “Blank database” option

• If not, use a template to guide you through the process
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Creating a Database (2 of 4)

•To Create a Database Using a Template

• If you have another database open, close it without exiting 
Access by clicking File on the ribbon to open the Backstage 
view, and then clicking Close

• If you do not see a template that you want, you can search 
Microsoft Office online for additional templates

• Click the template you want to use.  Be sure you have 
selected one that indicates it is for a desktop database

• Enter a file name and select a location for the database

• Click the Create button to create the database

-11-



Creating a Database (3 of 4)

•To Create a Database Using Blank Database Option

• Click the Blank database button

• Type “CMF Vets” in the File Name text box

• Click the Create button to create the database
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Creating a Database (4 of 4)

-13-



The Access Window

•Navigation Pane and Access Work Area

•Define the following (see the figure on the previous slide)

-Access work area

-Object tabs

-Navigation Pane

-Status bar

-Datasheet view (vs design view)

-Datasheet (a collection of rows and columns)
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Determining Tables and Fields (1 of 2)

•Naming Tables and Fields

•Names can be up to 64 characters in length

•Names can contain letters, digits, and spaces, as well as 
most of the punctuation symbols

•Names cannot contain periods (.), exclamation points (!), 
grave accent (`), or square brackets ([])

• Each field in a table must have a unique name

• In this book all names begin with an uppercase letter
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Determining Tables and Fields (2 of 2)

•Determining the Primary Key for Each Table

•A unique identifier (e.g.  Patient ID, Owner ID, etc.)

• If not determined, Access will create one field called ID

-An autonumber field (will be “1” for the 1st record, “2” for the 
2nd record, ….) 

•Determining Data Types for the Fields

•Data types:

-Short Text (up to 255 characters)

-Number

-Currency

-Date & Time

-Other Data Types
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Creating a Table in Datasheet View 
(1 of 18)

•Datasheet view—rows and columns, like a spreadsheet; 
shows each data record

•Design view—only used to create a table or to modify 
the structure of a table and has more functionality for 
creating a table; shows the fields, data types, properties 
and the primary key

•Caption—an assigned value to a field; when used the 
value of the caption will be displayed rather the field 
name

•When a database is created, Access automatically 
creates a table. We can then define all the fields.
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Creating a Table in Datasheet View 
(2 of 18)

•To Modify the Primary Key

• Right-click the column heading for the ID field to display a 
shortcut menu

• Click Rename Field to highlight the current name

• Type “Owner ID” to assign a name to the new field

• Click the white space below to complete the name change

• Click Table Tools Fields tab

• Click Data Type arrow (Formatting group) to display a menu

• Click “Short Text” to select the data type
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Creating a Table in Datasheet View 
(3 of 18)

•To Modify the Primary Key (Continued)

• Click the Field Size text box (Table Tools Fields tab | 
Properties group) to select the current field size (255), use 
either the DELETE or BACKSPACE key to erase the current 
field size, and then type the new field size (5)

• Click the Name & Caption button (same tab & group as  
above) to display the Enter Field Properties dialog box 

• Click the Caption text box (Enter Field Properties dialog 
box), and then type the desired caption (O_ID)

• Click the Description text box, and then type the desired 
description (“Unique identifier of pet owner”)

• Click the OK button to change the caption and description
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Creating a Table in Datasheet View 
(4 of 18)

•To Define the Remaining Fields in a Table

• Click the “Click to Add” column heading to display a menu of 
available data types

• Click the desired data type (“Short Text”)

• Type the desired field name (“Owner First Name”)

• Click the blank space below the field name to complete the 
change of the name. Click the blank space a second time to 
select the field

• If necessary, enlarge the field to display the entire name by 
double clicking between Owner First Name and the Click to 
Add box

• Change the field size (50)
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Creating a Table in Datasheet View 
(5 of 18)

•To Define the Remaining Fields in a Table (Continued)

•Use the same technique to add the remaining fields:

-Owner Last name  (Short Text, 50)

-Owner Street  (Short Text, 255)

-Owner City  (Short Text, 50)

-Owner State  (Short Text, 2)

-Owner Postal Code (Short Text, 9)

-Home Phone  (Short Text, 25)

-Mobile Phone  (Short Text, 25)

-Email Address  (Short Text, 50)
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Creating a Table in Datasheet View 
(6 of 18)

•Making Changes to the Structure

•Undo (Quick Access Toolbar)

•Delete a field (right-click the column heading)

• Change the name of a field (right-click the column heading)

• Insert a field as the last field (click the “Click to Add” 
column heading)

• Insert a field between existing fields (right-click the 

column heading of the field that follows the new field)
•Move a field (click the column heading and drag to the 

desired the position)
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Creating a Table in Datasheet View 
(7 of 18)

•To Save a Table

• Click the Save button on the Quick Access Toolbar to 
display the Save As dialog box

• Type the desired table name (“Owners”)

• Click the OK button (Save As dialog box) to save the table
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Creating a Table in Datasheet View 
(8 of 18)

•To View the Table in Design View

• Click the View button arrow (Table Tools Fields tab | Views 
group) to display the View menu

• Click Design View on the View menu to view the table in 
Design view
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Creating a Table in Datasheet View 
(9 of 18)

•Checking the Structure in Design View

• Carefully check the entries made

•Use the row selector to display field properties

•Make necessary changes

• Remember to save if changes are made

• For example, the key symbol indicates Owner ID is the 
primary key of the table. Clicking Owner ID field’s row 
selector will show the properties of that field, such as its 
caption is O_ID
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Creating a Table in Datasheet View 
(10 of 18)

•To Close the Table

• Click the Close button for the open table to close the table
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Creating a Table in Datasheet View 
(11 of 18)

•To Add Records to a Table

• Run Access, open desired database, open Navigation Pane

•Open the table (Owners) in Datasheet view

• Click the “Shutter Bar Open/Close Button” to close the 
Navigation Pane

• Click the first row to enter data, pencil icon indicates record 
is being edited, but not saved yet

• Enter data, use the TAB key to move to the next field
O-1, Ted, Sabus, 460 West Pioneer Road, Dolores, CO, 81323, 

 719-231-4411, 719-888-7735, tsabus@cengage.com

O-2, Steven, Nguyen, 9874 South Main Street, Blanding, UT, 84511

 435-991-5670, 435-777-6219, snguyen@cengage.com 

• Close the table, Exit Access
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Creating a Table in Datasheet View 
(12 of 18)

•Making Changes to the Data

•Undo 

•Add a record { click the “New” button (Home tab | Records 
group }

•Delete a record (click the record selector and DELETE)

• Change the contents of a field (select the field and update)

-28-



Creating a Table in Datasheet View 
(13 of 18)

Table 1-4 Navigation Buttons in Datasheet View

Button Purpose

First record Moves to the first record in the table

Previous record Moves to the previous record

Next record Moves to the next record

Last record Moves to the last record in the table

New (blank) record
Moves to the end of the table to a 
position for entering a new record
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Creating a Table in Datasheet View 
(14 of 18)

•Design view is the most efficient way to create a table 
because you can specify field name, data type, and size 
all in one view

•To Create a Table in Design View

•Display the Create tab then click the Table Design button 
(Tables group) to display the table in Design view

• Click the 1st empty field and start to enter the field names:
Patient ID, Patient Name, Animal Type, Breed, Owner ID: all short text

• Click the Patient ID row selector, if necessary, then click 
Primary Key (Table Tools Design tab | Tools group)

• Click the Save button and enter the name (“Patients”)
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Creating a Table in Datasheet View 
(15 of 18)

•Correcting Errors in the Structure (Design View)

•Deleting fields

-Right-click the row selector and select Delete Rows

• Inserting fields

-Right-click the row selector after the new row and select Insert 
Rows 

• Correcting primary keys

-Click the correct primary key entry and click the Primary Key 
button

•Moving fields

-Click the row selector of the field and drag it to the desired 
position
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Creating a Table in Datasheet View 
(16 of 18)

•Populating the Patients Table

• It means entering data into the table

• Click the View button to change to Datasheet view

• Enter patient data 

Patients Data

Patient ID Patient Name Animal Type Breed Owner ID

C-1 Paws Feline Calico O-2

C-2 Ranger Canine Labrador O-1

F-1 Fluffy Feline Tabby O-1
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Creating a Table in Datasheet View 
(17 of 18)

•To Resize Columns in a Datasheet

•Double-click the right boundary of the field selectors of 
each of the fields to resize the columns to best fit the data

• Save the changes to the layout by clicking the Save button 
on the Quick Access Toolbar

•To Close the Table

• Click the Close button for the open table to close the table
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Creating a Table in Datasheet View 
(18 of 18)

• Importing Additional Access Database Tables into an 
Existing Database
• Open the desired database (CMF Vets)

• Click on External data on the ribbon to display the External Data 
tab

• Click the “New Data Source” button (import & Link group)

• Point to From Database to display a menu and then click Access 
to display the “Get External Data - Access Database” dialog box

• Click the Browse button and navigate to the desired source file 
(“Support_AC_CMF Vets Extra Tables”) and then click Open 

• Click “Import tables, queries, forms, reports, macros, and 
modules into the current database” option box

• Click OK, then Select All, then OK

• Click Close (don’t check “Save import steps”)

• Open the table and explore the data
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•Query – a simple question about the database

•The Simple Query Wizard is the quickest and easiest way 
to create a query.

•The following query displays the Owners’ first and last 
name, the street address, city, state, and postal code

•To Use the Simple Query Wizard to Create a Query

• If necessary, open the Navigation Pane

• Select the table you wish to query (“Owners”)

• Click Create on the ribbon to display the Create tab

• Click the Query Wizard button (Create tab | Queries group) 
to display the New Query dialog box

Additional Database Objects (1 of 8)
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Additional Database Objects (2 of 8)

• To Use the Simple Query Wizard to Create a Query (Continued)
• Be sure Simple Query Wizard is selected, and then click the OK 

button (New Query dialog box) to display the Simple Query Wizard 
dialog box

• Select Owner First Name field and click Add Field ( > ) button

• Select Owner Last Name and click Add Field ( > ) button

• Using the same technique, add Owner Street, Owner City, Owner 
State, and Owner Postal Code

• Click Next to move to the next screen

• Confirm that the title of the query is “Owners Query” and “Open 
the query to view information” is selected

• Click the Finish button to create the query

• Click the Close button for the Owners Query to remove the query 
results from the screen. 

-36-



Additional Database Objects (3 of 8)

•Using Queries

• To change the design of the query, right-click the query 
(Owners Query) in the Navigation Pane and click Design 
View in the shortcut menu

• To view the results of the query, click the Run button 
(Design tab | Results group) to run the query and display 
the results in Datasheet view

• To view results from the Navigation pane, right-click the 
query (Owners Query) and click Open from the shortcut 
menu
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Additional Database Objects (4 of 8)

•A form displays all the fields but only for one record 

•To Create a Form

• Select the table (Owners) in the Navigation Pane for which 
you want to create a form

• If necessary, click Create on the ribbon to display the 
Create tab

• Click the Form button (Create tab | Forms group) to create 
a simple form

• Click the Form View button on the Access status bar to 
display the form in Form view (Form view allows changes 
to the data. Layout view allows changes to the look. Design 
view allows changes to the form.)
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Additional Database Objects (5 of 8)

•To Create a Form (Continued)

• Click the Next record button to move to the next record

• Click the Save button on the Quick Access Toolbar to 
display the Save As dialog box

• Type the desired form name (“Owners Form”), and then 
click the OK button to save the form

• Click the Close button for the form to close the form

•Using a Form

•After saving, right-click the form in the Navigation Pane and 
then click Open

• You can now view, enter, or update the data.

• If you want to revise the data, view in Form view
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Additional Database Objects (6 of 8)

•Reports show the data in a format easily distributed as 
hardcopy or other formats

•To Create a Report Using the Report Wizard

• Select the table (Owners) in the Navigation Pane for which 
you want to create the report

• Click Create on the ribbon to display the Create tab

• Click the Report Wizard button (Create tab | Reports group)

• In Available Fields, select desired fields, then click Add Field 
button ( > ) to add the fields to the Selected Fields area

-Owner First Name, Owner Last Name, Owner Street, Owner City, 
Owner State
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Additional Database Objects (7 of 8)

•To Create a Report Using the Report Wizard (Continued)

• Click Next, and select fields (Owner State) for grouping, click 
Add Field button ( > ) {report will be grouped on Owner State}

• Click Next and Next again (no sort is specified)

• Click the Stepped layout option to indicate the layout style, 
then click Portrait Orientation, leave Adjust the field width 
checked (so all fields fit on a page)

• Click Next, change the report title to Owners Report

• Leave the “Preview the report” option checked, then click 
Finish to complete the creation of the report

• Close the report by clicking the Close button
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Additional Database Objects (8 of 8)

•Viewing a Report Using Different Views

• Report view—shows on the screen

• Print Preview—shows how the report will appear when 
printed

• Layout view—shows on the screen, but you can make 
changes to field names

•Design view—allows you to make complex changes, but 
does not show report data
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Database Properties

•Database properties are details about a file

• project author, title, subject, keywords

• date you create or change a file, file size, etc.

•To Change Database Properties

• Click FILE on the ribbon to open the Backstage view

• If necessary, click the Info tab in the Backstage view to 
display the Info gallery

• Click the “View and edit database properties” link in the 
right pane of the Info gallery

• Enter the desired database properties

• Click the OK button to save your changes
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Special Database Operations (1 of 3)

•To Back Up a Database

•Open the database (“CMF Vets”) to be backed up

• Click FILE on the ribbon to open the Backstage view, and 
then tap or click the Save As tab

•With Save Database As selected in the File Types area, click 
“Back Up Database” in the Save Database As area, and then 
click the Save As button

•Navigate to the desired location in the Save As box. If you 
do not want the name Access has suggested, enter the 
desired name in the File name text box

• Click the Save button to back up the database
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Special Database Operations (2 of 3)

•When you delete objects, the released space may not 
become available to the other objects. To remove the 
empty space from the database, we must compact the 
database. This process also repairs problems that might 
have occurred in the database.

•To Compact and Repair a Database

•Open the database (“CMF Vets”) to be compacted

• Click FILE on the ribbon to open the Backstage view, and 
then, if necessary, select the Info tab

• Click the “Compact & Repair Database” button in the Info 
gallery to compact and repair the database
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Special Database Operations (3 of 3)

•Additional Operations

• Closing a database without exiting Access
-File -> Close

• Saving a database with another name
-File -> Save As ( Save Database As & Access Database ) -> Save As -> 
(New database name) -> Save

•Deleting a table or other object in the database
-Right-click the object in the Navigation Pane

-Click Delete on the menu and Click Yes in the dialog box

• Renaming an object in the database
-Right-click the object in the Navigation Pane

-Click Rename on the menu and type the new name and press ENTER
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